
Excel manual for STA 225, Fall 2025 

Content Pages Textbook 
sections 

General Comments 
 

3-5 NA 

One quantitative response variable 
• No explanatory variables 

o Descriptive statistics 
• Mean, median, standard deviation, IQR, 

range, percentiles 
• 5 number summary (min, Q1, median, Q3, 

max) 
 

6-9 3.1, 3.2, 3.4 

One quantitative response variable 
• No explanatory variables 

o Graphical summaries 
• Histograms and boxplots 

 

10-13 2.2, 3.4 

One quantitative response variable 
• No explanatory variables 

o Inferential statistics 
• Paired data 

o Hypothesis testing (One sample t 
test) 

o Confidence intervals (One sample 
t interval) 

 

14-20 9.4, 10.3, 8.2 

One quantitative response variable 
• One categorical explanatory variable  

o Descriptive statistics and graphical summaries 
• Comparing components of a 

quantitative distribution (center, 
variability, shape, outliers) across 
groups 

 

21-27 3.1, 3.2, 3.4, 
2.2 

One quantitative response variable 
• One categorical explanatory variable  

o Inferential statistics 
• Hypothesis testing (Two independent 

sample t test) 
• Confidence intervals (Two independent 

sample t interval for difference in 
means) 

 

27-29 10.2 



One Quantitative Response Variable 
• One quantitative explanatory variable (Simple Linear Regression) 

o Descriptive statistics and graphical summaries 
• Scatterplot (including detection of non-

linearity and outliers) 
• SLR model, correlation, r-square 

o Inferential statistics 
• P-value for testing slope, CI for slope 
• checking conditions 

 

30-37 2.4, 14.1, 
14.5, 14.6, 
14.7,14.8, 
14.9 

One Quantitative Response Variable 
• Two or more quantitative explanatory variables (Multiple Linear 

Regression) 
o Descriptive statistics and graphical summaries 

• Scatterplots 
 

38-39 2.4 

One Quantitative Response Variable 
• Two or more quantitative explanatory variables (Multiple Linear 

Regression) 
o Descriptive statistics and graphical summaries 

• Correlation matrix (including collinearity) 
 

40-41 15.5 

One Quantitative Response Variable 
• Two or more quantitative explanatory variables (Multiple Linear 

Regression) 
o Descriptive statistics and graphical summaries 

• MLR model, R-square, Adj R-square 
o Inferential statistics 

• P-value for overall F test, p-value for 
individual slopes 

• Checking conditions 
 

42-44 15.1, 15.3, 
15.5, 15.8 

One categorical response variable 
• No explanatory variables 

o Descriptive statistics and graphical summaries 
• Proportion 
• Bar chart and pie chart 

 

45-50 2.1 

One categorical response variable 
• No explanatory variables 

o Inferential statistics 
• Confidence interval and margin of error 

51 8.4 

 

  



General comments: 

STA 225 will be taught using the Excel “add-in” called the Data Analysis Toolpak.  This was specifically 
requested by Seidman College of Business (SCB) faculty, so you should use the Data Analysis Toolpak. 

Here is how to verify within Excel if the Excel Data Analysis Toolpak is activated, and how to activate if 
not already activated:  

https://www.goskills.com/Excel/Resources/Excel-data-analysis-toolpak 

This manual follows the order of topics that was used in development of STA 225 in cooperation with 
SCB faculty.  However, individual STA faculty can determine the order of topics to use in their STA 225 
sections. 

This manual was developed using the version of Excel that is on the GVSU network in Fall 2025. 

We assume that the reader understands that “response variable” is equivalent to “dependent variable” 
or “output variable”, and “explanatory variable” is equivalent to "independent variable” or “predictor 
variable” or “input variable”. 

We acknowledge that there is always more than one way to create statistical output with Excel, so we 
show what we think is the simplest approach here that would be sufficient at the STA 225 level, while 
utilizing the Data Analysis Toolpak when that contains the simplest implementation for a given task.  We 
generally shy away from using Excel functions, but keep in mind that your instructor may have another 
way that they want you to handle these issues. 

Important note on data structure:  Data that include a categorical variable can be organized in two 
different ways, and it is important to note which you have before you start analyzing it, because the data 
used with our textbook sometimes will be organized one way and sometimes the other, and this 
happens in the real world every day too.  The basic difference is whether or not all the variable values 
and categories in each individual row in the spreadsheet correspond to one individual subject (also 
called observational unit).  If each row corresponds to only one individual subject, the data are often 
called “tidy”.   

For example, the following two spreadsheets represent the same data, but they are structured 
differently.  For each university represented in the data, there is a quantitative variable called percent 
that is the percentage of students (out of 100%) from out of state, and also a categorical variable called 
type that is if the university is public or private.  The data on the left are “untidy” because each row has 
percentages from two different universities that have no connection to each other (so the data are not 
paired), and another indicator is that there are more values in the public column than in the private 
column.  Put another way, there is no variable observed from each university called “public” or “private”.  
However, the data on the right are “tidy” because both variables (percent and type) in each row come 
from the same university, so in other words, “percent” and “type” are variables observed from each 
university.  Note that not all values from the actual data set were included in the following images. 

https://www.goskills.com/Excel/Resources/Excel-data-analysis-toolpak


                       

  Untidy data       Tidy Data 

As you can probably guess from the name “tidy”, it is generally considered best practice to organize data 
in tidy form, but we can handle either tidy or untidy data with Excel, but you have to first recognize 
which you have, because how you use Excel depends to some extent on if the data are tidy or not.  The 
good news is that it is easy to convert from one format to another just by doing a little copying and 
pasting in Excel, but that isn’t necessary if you’re willing to have some attention to detail.  The point is 
that it is very important that you are aware of this issue going forward, regardless of if you choose to use 
tidy or untidy data in your analyses.  You should follow the directions of your instructor on this issue. 

 

Some of the following analyses were implemented using the carvalues data set that comes with the 
Camm et al textbook (Ch 15) and others come from the collegecosts data set (Ch 10) partially shown 
above, or the golfscores data set (Ch 10) for a paired data example.  Here are the first 10 rows of the 
carvalues data set to help understand the variables (this data set is in tidy format): 

 

 



If the Data Analysis Toolpak add-in is activated, you can access the features by going to the Data tab at 
the top middle, and then click on “Data Analysis” on the far right at the top. 

 

This will show you a list of features you can choose from, and we will refer to these in the rest of the 
document. 

 

Important note:  If you cannot get any of the features of this add-in to work, make sure you have clicked 
on “Enable Editing” if that is an option.   

 

  



One quantitative response variable 
o No explanatory variables 

 Descriptive statistics 
• Mean, median, standard deviation, IQR, range, 

percentiles 
• 5 number summary (min, Q1, median, Q3, max) 

To get Excel to calculate most of the basic descriptive statistics for one quantitative variable, we use the 
Data Analysis Toolpak add-in, and use the Price variable in the carvalues data set.  As described above, 
click on the Data tab, and then the Data Analysis icon on the far right at the top.  Select Descriptive 
Statistics option as shown below, and click OK 

 

Which should show this dialog 

 

 

 



Single click in the Input Range box.  Because it is appropriate to include every value of Price in this 
scenario, we can highlight the entire column C, but in general be careful to only highlight values that are 
relevant.  Check the box for Labels in first row, because the variable name Price is in the first row. 

To paste the output into the same spreadsheet, click on Output Range, single click in the box next to 
Output Range, and then click on a cell where you want the output.  Check the box for Summary 
Statistics. 

 

You should now see many of the common descriptive statistics to the right of the data, though we will 
have to do something else to get Q1, Q3 and IQR. 

 

Excel uses a slightly different method to calculate percentiles.  You should read the percentiles portion of 
Section 3.1 in the textbook to see how this is done.  The short answer is that linear interpolation is used, 
so be aware that other ways you may have seen to hand calculate percentiles will likely not match what 
Excel is doing.  The different methods generally produce similar answers, and because Excel is the official 
software for STA 225, we will follow the method used by Excel. 

In the Data Analysis Toolpak, there is a Rank and Percentile feature, but this will not give us Q1 and Q3 
directly.  This feature will give a percent for each value of a given variable, which is not what we want.  
So this is one of the few times that we will revert to using an Excel function, because it is the easiest way 



to get Q1 and Q3 with Excel.  Keep in mind that this will likely not match what you get in other software 
or the graphing calculator, and may not match methods of hand calculation you have seen prior to this 
class.  As stated above, we choose to follow how Excel does things.  The function we use, 
PERCENTILE.EXE, matches what is done in the textbook.  You can use it to get any percentile, but we 
focus on Q1 and Q3 here. 

Pick a cell where you would like to have the value of Q1 placed, and then start typing  
=percentile.exe 
You’ll then need to highlight the values you are focused on, here all of the values for price (without the 
first row where the variable name is located).  For Q1, we tell Excel we want the 0.25 percentile. 

 

If you hit enter, then you should see the value 21863.75 as shown below, and then Q3 (75th percentile) 
can be calculated the same way. 

 

Once you have Q1 and Q3, you can manually calculate IQR = Q3-Q1, or you can tell Excel to do it 

 

 



One quantitative response variable 
o No explanatory variables 

 Graphical Summaries 
• Boxplots and histograms 

To make a histogram of one quantitative variable (here, we use the variable price from the carvalues 
data), first highlight the Price column and then click on the Insert tab, and then click on the Histogram 
button, and then click on the icon for the traditional histogram.  Note that we are not yet interested in 
subsetting the data by a categorical variable like Size, so we can select the entire Price column.  However, 
in the future, we will need to select only those cells that are relevant.  The point is that you will not 
always be able to select an entire column. 

 

This should insert a histogram as follows, though we may wish to alter it.  For example, , we may wish to 
change the title or axis labels.  To do so, click on the + icon at the top right 

 

And then click on various parts of the graph to make changes like this (you can literally type the Title and 
axis labels inside the graph by clicking on those aspects inside the graph). 



 

To change the width of the bins, you can right click on one of the intervals that are labeling the 
horizontal axis, and then select Format Axis 

 

 

which will allow you to select Bin width and change the Bin width to whatever makes the most sense.  
This will change the number of bars in the histogram. 

 

I changed the Bin width to 3000 and hit enter, which gave this histogram.  You can also choose to alter 
the Number of bins of you prefer. 



 

If these are all the changes your instructor would like you to make, you can copy this histogram and 
paste it into another document for submission. 

To make a boxplot of one quantitative variable, you can use the same steps as for the Histogram, but 
instead choose Box and Whisker.  Boxplots produced this way will show outliers when they are present. 
Don’t forget to first highlight the data that you are interested in (which may not be an entire column in 
general, but it is in this example): 

 

Which should produce the basic boxplot as follows.  You can make updates to the Title and axis labels as 
described for the Histogram above. 



 

Here I changed the Title, axis label on the vertical axis, and deleted the horizontal axis label and the 
value 1 on the horizontal axis, because we only have one group in this example.  We’ll handle side-by-
side boxplots in the coming pages. 

 

 

 

 

 

 

  



One quantitative response variable 
• No explanatory variables 

o Inferential statistics 
• Paired data 

o Hypothesis testing (One sample t test) 
o Confidence intervals (One sample t interval) 

 
It is important to note that the feature of the Data Analysis Toolpak that can be used for the calculations 
for paired data t test and confidence interval do not check the assumption of the paired t test or 
confidence interval.  In order to do that, we first must create the paired differences by creating a new 
variable, and check to see if the paired differences are reasonably normally distributed (unless the 
sample size is sufficiently large) by making appropriate graphs like histograms and boxplots. 

Here we use the golfscores data set, because these are truly paired, meaning the two scores in each row 
come from the same golfer on the same course, so it makes sense to subtract the scores, to get a 
difference for each golfer.  In fact, we’ll need to do that to check to see if the differences are reasonably 
normal.  First create a new column with the differences by doing the following.  You’ll need to type in a 
very simple formula and then hit enter.  Note that I did Round 2 minus Round 1, because Round 2 came 
later in time. 

 

Then you can copy the formula from cell D2 to the rest of the cells below D2. 

 



It is a good idea to manually check a few values in the new column to make sure Excel did what you 
wanted it to do.  If this checks out, then you can make a boxplot or histogram to check normality as 
described above, including altering title and axis labels (unless the sample size is sufficiently large). 

 

To get Excel to calculate paired t test statistic, p-value and confidence interval, you need to use the Data 
Analysis Toolpak add-in, but you won’t use the difference column that you just created.  As described 
above, click on the Data tab, and then the Data Analysis icon on the far right at the top.  Select the t-test: 
Paired Two Sample for Means option as shown below, and click OK 

 

 

That will open this dialog 



 

Single click in the Variable 1 Range, and then highlight the column for Round 1, and then click in Variable 
2 Range and highlight the column for Round 2.  We can take the whole column for each of these in this 
example, but in general that may not be OK.  Only highlight the data you want Excel to use. 

 

Put the null hypothesis value in the box for Hypothesized Mean Difference, which is typically 0.  Check 
the Labels box because the first row of data has the variable names.  Put in appropriate Alpha value if 
not 0.05.  If you want the output to show up in the same spreadsheet, you can click on Output Range, 
click in the box to the right of Output Range, and then select a cell in the spreadsheet where you’d like 
the output to show up.  Then click OK. 



 

This is what I get when I do this (putting Round 2 in Variable 1 Range and Round 1 in Variable 2 Range to 
be consistent with how the differences were formed by using Round 2 minus Round 1. 

 

Note that there are some strange values in the output, specifically #DIV/0!.  Excel says we asked it to 
divide by 0, but the real issue is the with the variable name in the first row.  We can get around this 
(because I don’t know how to fix the variable name) by just highlighting the data instead of the entire 
column, as you can see here, but you should uncheck Labels, because we’re not including the variable 
name in the first row.  To be consistent with how I created the difference column, I put Round 2 in 
Variable 1 Range and Round 1 in Variable 2 Range (you can tell by which has higher mean and the sign on 
the test statistic).  This order will matter if you are intending to do a one tail test (to make sure you are 
consistent with how you set up the alternative hypothesis), but it will not matter for a two tail test. 



Now you can extract the paired t test statistic and p-value, being careful to note which p-value to use, 
one tail or two tail. 

Note that it is very easy to get a paired t test wrong when you are doing a one tail test.  Make sure that 
when you set up the hypotheses, you take into account both (1) how you subtracted to create the 
differences and (2) what claim you are supposed to test from the wording of the problem.  This 
confusion can easily translate into reading Excel output as well. 

 

The Paired Two Sample for Means option in the Data Analysis Toolpak does not give a confidence interval 
for the population mean difference.  However, we can use the Descriptive Statistics option shown below, 
applied the difference column. 

 



To do this, you can highlight the entire column for difference (including the first row), but be sure check 
the box for Labels in first row.  You’ll also want to check the box for Confidence Level for Mean, you also 
need to check the box for Summary Statistics (because you’ll need the value of the sample mean, as 
you’ll see). 

 

Excel gives the following output 

 

Note that Excel does not give the confidence interval directly.  In the bottom row of the output, we see 
the value of 1.552042.  This is technically the “margin of error”, which by formula for one quantitative 
variable is 𝑡𝑡∗𝑠𝑠/√𝑛𝑛, or in other words, everything after the +/- in the confidence interval formula.  So to 
get the lower and upper bounds on the confidence interval, you have to calculate mean – 1.552042 and 



mean + 1.552042, where mean = 1.05 from the output for this example.  So the 95% confidence interval 
for the population mean difference is (-0.50, 2.60), rounded to two decimal places.  Because we’re 
dealing with paired data here, take care to remember which way you subtracted in creating the 
differences (in this example, Round 2 minus Round 1) before interpreting the confidence interval. 

One quantitative response variable 
• One categorical explanatory variable  

o Descriptive statistics and graphical summaries 
• Comparing components of a quantitative distribution 

(center, variability, shape, outliers) across groups 

This kind of analysis is where the issue of tidy vs untidy is relevant because there will be a categorical 
variable that determines which group each subject belongs to.  Regardless, you’ll still have to highlight 
the correct portion of data for the analysis, so focus on that. 

When summarizing a quantitative response variable by different groups, you just need to use the 
Descriptive Statistics feature of the Data Analysis Toolpak multiple times, once for each group.  For 
example, to summarize Price for just Small Sedans, you can highlight only the values of Price that 
correspond to Small Sedans.  You may have to first sort the data by the categorical variable (here Size).  
Note the range of values in Input Range are just C2 to C14. 

 

Then you can repeat for Family Sedan.  Note that Input Range now has C15 to C33, which corresponds to 
Family Sedan.   



 

You may wish to type over “Column 1” to minimize confusion, which I replaced here with Small Sedan 
and Family Sedan in the first row, above the corresponding output. 

 

Getting percentiles works the same as above, just make sure to only give Excel the range of values for a 
given category. 

Making side-by-side boxplots is actually easier if data are in untidy form, though we show how to get 
side-by-side boxplots for both untidy and tidy forms.  First we show untidy, so we switch to using the 
collegecosts data set. 

First highlight the data for both Private and Public (remember, these data are untidy because the two 
values in each row come from unrelated universities), then go to the Insert tab, and pick boxplot as show 
earlier 



 

You should see the following output, which you can adapt as shown earlier. 

 

For tidy data, we use the carvalues data set (this is tidy because all values and categories in one row all 
come from the same car).  Making side-by-side boxplots is a little more complicated than for untidy data.  
First make a boxplot for one group, and then you’ll have to insert a second one for the other group.  
We’ll compare prices of Small Sedans vs Family Sedans.  If the data were not already sorted by the 
categorical variable Size, you would first want to do that. 



 

Then we want to add in a boxplot for the Family Sedans.  To do that, right click in the graph so that you 
see the Select Data option 

 

If you click on Select Data, you should see this window 

 

Series1 is the Small Sedan data we already plotted.  We can rename that from Series1 to Small Sedan by 
clicking on Series1 and then Edit and then click OK as shown below 



  

Which should show you this (after you type Small Sedan into Series name). 

 

Then click OK, which should have Small Sedan in place of Series1.  Now we want to add a new series for 
Family Sedans, so click on Add 

 

Then type Family Sedan into Series name, and then single click in Series values, and highlight the price 
values that correspond to the Family Sedan category (shown in red in the screen shot below), which 



should look like this.  Then click OK, and then click OK one more time, and you have side-by-side 
boxplots, though we’ll want to add appropriate labels, which we do next. 

 

Now if you click on the graph, and click on the + in the upper right, you’ll be able to check the box for 
Legend 

 

Which will label which boxplot is which.  You will probably want to adapt the Chart title and add axis 
labels, but that works the same as shown above.  Click on Axis Titles to add those, and just click on Chart 
Title at the top to alter that.  You can delete the number 1 below the chart just by clicking on it and then 
hitting delete. 

  



One quantitative response variable 
• One categorical explanatory variable  

 Inferential statistics 
• Hypothesis testing (Two independent sample t test) 
• Confidence intervals (Two independent sample t 

interval for difference in means) 

In order to implement the two independent sample t test, you should first check conditions of the test.  
That may (depending on sample size) involve checking for normality of each group, which can be done 
using histograms or boxplots as show above.  To get the test statistic and p-value from Excel, we can use 
the Data Analysis Toolpak as shown next.  We’ll use the carvalues data set which is in tidy form, but you 
can easily do this for untidy data as well, just by highlighting the appropriate values (so having tidy data 
for this purpose is not a big deal). 

Suppose we want to test for the equality of population means of Price for small sedans vs family sedans 
(from the Size variable).  We will always focus on using the unpooled t test (and confidence interval) in 
STA 225, so you should find the option show below that says “Assuming Unequal Variances”. 

 

  



Then you need to click in the box next to Variable 1 Range, and then highlight the Price values (without 
the word Price in the C1 cell) for small sedan.  Then click in the box next to Variable 2 Range and 
highlight the Price values for family sedan.  Because the null hypothesis for this test will always be that 
the population means are equal in STA 225, we will always put 0 in Hypothesized Mean Difference.  Do 
NOT click on the box for Labels (because we did not highlight the C1 cell with the variable name Price in 
it).  Then you can click on Output Range and tell Excel where you want to see the output, here I chose 
cell H1. 

 

When you click on OK, you should get the following output where you told Excel to put the output.  The 
value “t Stat” of -7.76048 is the test statistic, and then you have to choose the p-value that is consistent 
with your alternative hypothesis.  Excel calls the p-value “P(T<=t)”, and then you decide if you need one 
tail or two tail.  You should ignore the “t Critical” values for the purposes of the hypothesis test.  Note 
that the degrees of freedom have been rounded to the nearest integer (the actual formula does not 
produce an integer). 

 

Unfortunately, the two independent sample t confidence interval is not built into Excel, even in the Data 
Analysis Toolpak.  That means we need to work a little harder using the formula, but we can minimize 
our work by harnessing the output from the two independent sample t test.  Recall from the textbook 
that the formula for the two independent sample t confidence interval is  

 

(𝑥̅𝑥1 − 𝑥̅𝑥2) ± 𝑡𝑡∗��
𝑠𝑠12

𝑛𝑛1
+
𝑠𝑠22

𝑛𝑛2
� 



If we want to apply this to the carvalues data set, where we want to compare population mean prices of 
small sedans to family sedans (as we did above with the corresponding hypothesis test), we have 
everything we need from the output from the hypothesis test.  Specifically, we have the values of the 
sample means (𝑥̅𝑥1 and 𝑥̅𝑥2) and sample variances (𝑠𝑠12 and 𝑠𝑠22), and also the sample sizes (𝑛𝑛1 and 𝑛𝑛2).  Very 
important:  the test statistic you see above is not the same as a critical value.  In other words, t and 𝑡𝑡∗ 
are not the same thing.  The critical value 𝑡𝑡∗ is also in the output called “t Critical two-tail”, which is 
different than the test statistic which you already know is called “t Stat”. 

So we can put all of this together into one cell, if we are careful about order of operations, and 
remember that standard deviation is the square root of variance, so be careful to distinguish between 
sample variance 𝑠𝑠12 and sample standard deviation 𝑠𝑠1 (without the square).  Excel gives us variance, 
which is squared standard deviation, so we don’t have to square when using the formula. 

 

Note that in cell H15, I am only calculating the left side of the interval.  We’ll have to repeat in cell H16 

for the right side of the interval, switching – to + in the formula:  (𝑥̅𝑥1 − 𝑥̅𝑥2) ±  𝑡𝑡∗��𝑠𝑠1
2

𝑛𝑛1
+ 𝑠𝑠22

𝑛𝑛2
�. 

 

When you interpret this confidence interval make sure to remember which group you called group 1 and 
which group you called group 2, because the confidence interval is estimating 𝜇𝜇1 − 𝜇𝜇2.  In this example, 
small sedan is group 1 and family sedan is group 2, so the confidence interval bounds being negative 
means that the population mean price for small sedans is less than the population mean price for family 
sedans.   

 



One Quantitative Response Variable 
o One quantitative explanatory variable (Simple Linear Regression) 

 Descriptive statistics and graphical summaries 
• Scatterplot 
• SLR model, correlation, r-square 

Here we’ll use the carvalues data set, specifically the Price variable as the response variable and Road-
Test Score as the explanatory variable.  To use the following method to create a scatterplot, the response 
variable needs to be to the right of the explanatory variable.  Because I want Price to be the response 
variable (and show up on the vertical axis or y-axis), I copied it to the far right.  There are other ways to 
get around this problem, but all are more complicated and no more effective. 

Then highlight the column for Road-Test Score, then hold down the ctrl button, and highlight the Price 
column on the far right side that you pasted on the far right side. 

 

Click on the Insert tab near the top left, select the menu for scatterplots, and from that list, the 
scatterplot as shown below. 

 

 

That should create the following scatterplot.  Note that Price is on the vertical axis (y-axis) as it should 
be. 



 

You will want to label the axes, so you can click on the + sign in the upper right (circled above).  Then you 
check the box for Axis Titles as circled below.   

 

You can click on the label for each axis to type the variable name for each.  You can also click on the main 
title and change it if you wish, which I did in the image below. 

 



Very important: For producing statistical analyses (not graphs) for regression, when you highlight the 
data for each variable, do NOT highlight the entire column, because this will cause an error, where Excel 
will show the following error message.   

 

You should only highlight the cells with numbers in them (rather than also including the empty cells 
below the cells with numbers in them), along with the variable name in the first row.  Here we want to 
use Price as the response variable and Road-Test Score as the explanatory variable, just as we did above 
for producing the scatterplot. 

Click on the Data tab at the top, and then Data Analysis on far right, and select Regression, and then click 
OK as shown below: 

 

This will create the following dialog, where you can tell Excel that Price is the Y (response) variable in 
Input Y Range, and that Road-Test Score is the X (explanatory) variable in Input X Range.  Note that I have 
included the first row (but no empty cells below the cells with numbers in them), which is the variable 
names, so I should click on Labels.  Then click on Residuals.  Your instructor may want you to select more 
options, but this is all we need for further analysis as shown in this document, so click OK.  Note that I 
told Excel to put the output in cell I1 (by clicking in Output Range and then clicking on cell I1), but you 
can put it wherever you like. 



 

This should produce output that looks like this (you’ll need to scroll to right and/or down to see all of it, 
and perhaps adjust column widths to see all labels below). 

 

 



The (linear) correlation coefficient is equivalent to what Excel calls “Multiple R”  (circled above) because 
we only have one explanatory variable (simple linear regression).  The equation of the least squares line 
can be written using the Coefficients values circled above.  The p-value to test the null hypothesis that 
the population slope can be found under P-value as circled above.  The 95% confidence interval for the 
population slope is also circled above.  For both the p-value and confidence interval, make sure you use 
the second row, which correspond to the explanatory variable, here Road-Test, as opposed to the first 
row which are for the y-intercept, which we generally will not be interested in. 

• Residuals, including graph of residual vs predicted values 

In order for the p-value and confidence interval to be valid, we need to check assumptions, just as for 
any hypothesis test or confidence interval.  First, we need that the scatterplot of the response variable 
and explanatory variable are linear and don’t have any extreme outliers, which can be done with a 
scatterplot as produced above.   

We also need that the residuals are normally distributed, and that the scatterplot of residuals vs 
predicted values shows constant variance (so does not have a funnel shape).  We have everything we 
need to create these plots because we told Excel to create these, which are circled below.  We can also 
detect outliers in either of the following plots, and look for non-linearity in the scatterplot of residuals vs 
predicted. 

 

You can make whatever kind of plot your instructor prefers for checking normality, and we showed 
earlier how to make histograms and boxplots.  You just have to apply them to the residuals.  I’ll use a 
boxplot here.  Highlight the residuals and then click on the Insert tab, and click on the icon that looks like 
a histogram as shown here (and as shown earlier), and then select Box and Whisker. 



 

This should produce the following boxplot of the residuals.  We can make the labels more appropriate, 
but regardless, the boxplot looks pretty symmetric and does not show any outliers.  Note the scale on 
the vertical axis has 0 in the middle, which is how you can verify you are actually plotting residuals.  In 
other words, residuals can be both positive and negative as circled below. 

 



To make a scatterplot of residuals vs predicted values, you can do exactly what we did earlier for 
scatterplots, but first highlight the predicted values (here, Predicted Price) and the residuals, and then 
click on Insert tab, and then the icon that looks like a scatterplot shown here: 

 

Which should produce this plot.  We can clean up the labels as before, but the point is that this plot does 
not show any funnel shape.  It also does not show any extreme outliers, and does not have any general 
pattern at all (like a linear pattern), which is what we hope to see. 

 

Because residuals can be negative, note that the vertical axis again has 0 in the middle (as circled above), 
which means the residuals are on the vertical axis as we would like. 

 



One Quantitative Response Variable 

• Two or more explanatory variables (Multiple Linear Regression) 
o Descriptive statistics and graphical summaries 

• Scatterplots of response variable vs each quantitative 
explanatory variable (including detection of non-
linearity and outliers) 

Note that in STA 225, we do not cover categorical explanatory variables (because SCB faculty preferred 
that we skipped that material), so our focus here is limited to quantitative explanatory variables. 

Very important:  In order to use the Regression feature of the Data Analysis Toolpak, the columns 
containing the explanatory variables must be next to each other in the spreadsheet.  The column for the 
response variable can be anywhere. 

In general, when performing multiple linear regression, the first step is to make scatterplots of all 
quantitative variables in pairs, regardless of which variable is the response variable and which variables 
are the explanatory variables.  This is often called a scatter matrix.  However, neither Excel nor the Data 
Analysis Toolpak has a way to do this.  This just means you should make all of these scatterplots one by 
one, to look for linearity, strong relationships and outliers.  Implementing these in Excel is no different 
than show above, you just need to make more of them.  Remember that the response variable needs to 
be to the right of the explanatory variable in the spreadsheet.   

For example, using the carvalues data set with Price as the response variable, I made one scatterplot of 
Price vs Cost/Mile as show below, by highlighting Cost/Mile, hold down the ctrl button, and then 
highlight Price, then make the scatterplot by clicking on the scatterplot icon as before. 

 



You should make a scatterplot of Road-Test vs Price, Predicted Reliability vs Price, and Value Score vs 
Price, to verify linearity and look for outliers.  It is also a good idea to make scatterplots of just the 
explanatory variables, so Cost/Mile vs Road-Test Score, Cost/Mile vs Predicted Reliability, etc., and look 
for strong relationships between the explanatory variables (to identify redundancy also known as 
collinearity), in addition to linearity and outliers. 

We are going to calculate correlations amongst all these pairs of variables next, and for correlations to be 
valid, we have to first verify linearity and no extreme outliers. 

 

One Quantitative Response Variable 
• Two or more quantitative explanatory variables (Multiple Linear 

Regression) 
o Descriptive statistics and graphical summaries 

• Correlation matrix (including collinearity) 

Even though Excel will not make a scattermatrix for us, it will make a correlation matrix.  This gives us a 
lot of information all at once.   

Go to Data tab, click on Data Analysis on far right, and select Correlation, and then click OK, as circled 
below. 

 

Click in Input Range, then highlight all relevant quantitative variables (both response variable and all 
explanatory variables).  Because I highlighted the variable names in row 1, I clicked on Labels in first row.  
Then you can tell Excel where to put the output.  I chose cell I1.  Then click OK. 

 



 

After adjusting column widths in the resulting table so I could see the variable names, I get the following 
table. 

 

 

The values (in the table we just produced) under Price circled above are the correlations of each 
explanatory variable with Price.  The other values (separately circled above) are the correlations 
between the explanatory variables, and ideally, we’d like all of these to be near 0.  For example, Value 
Score and Predicted Reliability have a moderate correlation of 0.64, which indicates we may not need 
both of them in a multiple regression model.  We’ll ignore this going forward for the purposes of this 
document, but that can be unwise in practice, because this is an indication of collinearity. 

  



One Quantitative Response Variable 
• Two or more quantitative explanatory variables (Multiple Linear 

Regression) 
o Descriptive statistics and graphical summaries 

• MLR model and prediction, especially as it relates to 
forecasting 

o Inferential statistics 
• P-value for overall F test, p-value for individual slopes 
• Checking conditions 

 

To get multiple linear regression output, you can follow the same steps as we did earlier for simple linear 
regression.  Remember that you should only highlight cells with numbers in them, as opposed to entire 
columns. 

Very important:  As noted above, all explanatory variables must be next to each other in the 
spreadsheet.  If they are not, then you need to do some copying and pasting to make this true before 
asking Excel to create output for multiple linear regression. 

 

Click in Input Y Range, and highlight cells under Price (not entire column), including the first row with the 
name Price in it.  Then click in Input X Range and highlight the cells in columns for Cost/Mile, Road-Test 
Score, Predicted Reliability and Value Score, making sure not to highlight the entire columns as before.  
Click on Labels and Residuals.  I asked Excel to put the output in cell I1 again. 



 

This should produce the following output, after clicking OK, and after adjusting the width of a couple 
columns so I could more easily read the labels. 

 

 



R-Square and Adjusted R-Square are circled above.  In the ANOVA table, Significance F is circled, which is 
the p-value simultaneously testing if all population slopes are 0.  The next table of output, under 
Coefficients, gives the sample y-intercept and sample slopes, which are circled.  In the same table under 
P-value are the p-values for testing if each individual population slope is equal to 0 (these are two-tailed 
p-values).  Note we are not interested in the p-value for the y-intercept. 

We still need to check for normality of residuals (boxplot of residuals) and constant variance in the 
residuals (scatterplot of residuals vs predicted values.  This is done the same way that we showed for 
simple linear regression, but we show it again here. 

 

 

 

 

 
 



One categorical response variable 
• No explanatory variables 

o Descriptive statistics and graphical summaries 
• Proportion 
• Bar chart and pie chart 

Here we use the carvalues data set, and focus on the Size variable, and supposed we want to focus on 
percent of cars that are small sedans.  We would technically need that our data set came from a random 
sample, but we’ll not worry about that for this example (though you should in general). 

First, we need to get Excel to tell us how many times each category appears.  You’d think this would be 
pretty easy in Excel, but it is not, or it is not as easy as it should be, meaning that there is nothing in the 
Data Analysis Toolpak to do this. 

The first step is to copy the categorical variable Size to the far right, because we are going to tell Excel to 
eliminate duplicate values, and we don’t want to do that in the original column.  This will allow us to tell 
Excel to count how many times each unique category appears in our data. 

Highlight the column for Size on the far right, then click on Data tab, and then in the Data Tools section, 
click on Remove Duplicates as circled below. 

 

Select Continue with the current selection in the box as show below, and then Remove Duplicates, and 
then in the next box that pops up, click OK. 



 

You should now see, so we can now use the COUNTIF function to get the frequencies for each of the 
three categories. 

 

First, we can get the number of Small Sedans by highlighting the original Size column (without 
highlighting row 1 where the variable name Size is) by clicking in the J2 cell, and then then typing the 
following as shown (which tells Excel to count how many times the category in I2 cell appears), and then 
hitting enter 



 

Then copy the formula in cell J2 and paste into cells J3 and J4 to get the following 

 

Which says that there are 13 Small Sedans, 20 Family Sedans, and 21 Upscale Sedans.  If we care about 
proportion of Small Sedans, we can just calculate 13 out of the sample size of n = 13+20+21 = 54, 
meaning that the sample proportion of Small sedans is  𝑝̂𝑝  = 13/54 = 0.25.  In other words, 25% of the 
sample is Small Sedan. 

 

  



To get a bar graph for one categorical variable, highlight the column with the categorical variable, and 
then click on Insert tab, then Recommended Charts 

 

And then click OK.  This will make a bar graph in an new sheet, and provide the same counts as given 
above.  See below for output.  The graph can be altered in the usual way. 

 

 



To get a pie chart, you have to first summarize the data into frequencies as we did above, or as done by 
the bar graph in the above image (Counts of 20, 13 and 21).  Highlight this table of counts, then click on 
Insert tab, and then the icon for Pie Charts circled below, and then select the first image under 2-D Pie. 

 

This should produce the following Pie chart, which can be altered in the usual way. 

 



One categorical response variable 
• No explanatory variables 

o Inferential statistics 
• Confidence interval and margin of error 

Though we don’t show it here, you should first check conditions of a confidence interval (CI), which are 
that both 𝑛𝑛𝑝̂𝑝 ≥ 10 and 𝑛𝑛(1 − 𝑝̂𝑝) ≥ 10 are true, and that the sample was taken randomly from the 
population. 

To get margin of error and confidence interval, we have to use the formulas because they are not built 
into Excel.  Recall that for a one categorical variable problem, the confidence interval formula f or the 

population proportion is 𝑝̂𝑝 ± 𝑧𝑧∗�𝑝𝑝�(1−𝑝𝑝�)
𝑛𝑛

  and the margin of error is just the part of this formula after the 

± , so ME =  𝑧𝑧∗�𝑝𝑝�(1−𝑝𝑝�)
𝑛𝑛

 . 

We know from above that 𝑝̂𝑝  = 0.25 and n = 54.  If we use 95% confidence, then 𝑧𝑧∗ = 1.96, and then the 
CI or ME can be calculated with a calculator, or typed into a cell in Excel. 

 


